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Chapter1
Db2 Web Query Administration Console

The Db2 Web Query Administration Console enables you to remotely manage your Db2
Web Query environment. Using the Console, administrators can navigate through and
change various configuration settings for the Db2 Web Query Client. 

In this chapter:

Accessing the Db2 Web Query Administration Console

Configuring Db2 Web Query

Changing Web Query Client Settings in Web Query

Working With HTML5 Chart Extensions

Accessing the Db2 Web Query Administration Console

You can access the Administration Console from the Db2 Web Query menu bar by clicking
Administration and then selecting the Administration Console option, as shown in the following
image.
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Configuring Db2 Web Query

To use the Db2 Web Query Administration Console to update Db2 Web Query Client
configuration settings, click the Configuration tab and select one of the categories in the menu
at the left side of the screen, as shown in the following image.

You can also click any of the following options located on the right side, along the top of the
screen:

Clear Cache. Clears your memory cache, which contains information that gets processed with
every Db2 Web Query Servlet request. This includes Db2 Web Query script and configuration
files, and the default Managed Reporting Driver cache.

By clearing the cache, it fully revokes the Report Broker scheduling privileges from a user. This
should be done after a user is moved into or removed from a folder-sched group.

Close. Closes the Administration Console. You are still logged into Db2 Web Query as an
administrator.

Help. Opens the online help file.

Configuring Db2 Web Query
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Application Settings

Application Settings determine the configuration and behavior of the Db2 Web Query web
application.

Procedure: How to View or Edit Application Settings

1. In the Administration Console, on the Configuration tab, expand the Application Settings
folder and click the node of the category of settings you would like to view or edit.

The settings appear in the main configuration pane.

2. Make the desired changes and click Save.

Reference: BI Portal Settings

BI Portal settings configure the display and behavior of the BI Portal.

Sign-in Message

Specifies a custom message that displays in the Messages dialog box when a user signs
in. You can enter plain text or HTML tags for text, links, and images, into this field. If you
leave this field blank, the Messages dialog box does not display.

The following HTML tags may be used in the sign-in message:

<l>, <br>, <b>, <u>, <a href>, </a>, <img>.

Sign-in Page Links

Determines whether the Db2 Web Query Sign in page displays or hides links.

When this check box is selected (True), the Db2 Web Query Sign in page displays
additional text and links to additional information or support sites. This is the default
setting.

When this check box is cleared (False), the Db2 Web Query Sign in page does not display
any additional supporting text of links, and limits the display to the Screen Title, User
Name, Password, and Sign in button.

Session Timeout

Controls the session timeout value, which limits the amount of time users can remain idle
before a session timeout takes place. This setting is defined in minutes, for example,
IBI_Session_Timeout=120.

1. Db2 Web Query Administration Console
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Reference: Client Settings

Client settings configure miscellaneous Client options. 

Maximum Response Window Size

Defines the maximum size, in bytes, allowed for responses in the original window when
using Internet Explorer. 

Responses larger than the size identified in this setting will be launched in a new window,
to ensure that it will open without errors. If this setting is blank, no maximum limit is
applied. The default value is 400,000 bytes.

Excel Server URL

Identifies the location of the resource that Web Query uses to render output in the Excel
2007 file (.xlsx) format.

The Excel Server URL drop-down list contains two options:

Reporting Server JSCOM Application Server (labeled as Default). Directs output to the
JSCOM3 listener on the Reporting Server, which will then render the output in the Excel
file format. The URL used by this setting is the URL of the JSCOM3 listener. Use this
option if you need to support SSL or any type of authentication other than the default
internal security. Web Query is configured for JSCOM, overriding the default option.

Default. Directs output to the IBIExcel Servlet on the mid tier, which will then render the
output in the Excel file format. The URL used by this setting is the Default URL for Web
Query. Use this option if you do not need to support SSL or any type of authentication
other than the default internal security. This is the default option.

Graph Server URL

Identifies the location of the resource that Web Query uses to render output in graph
image file format. 

The Graph Server URL drop-down list contains two options:

Default. Directs output to the IBIGraph Servlet on the mid tier, which will then render
the output in graph image file format. The URL used by this setting is the Default URL
for the Web Query. Use this option if you do not need to support SSL or any type of
authentication other than the default internal security. This is the default option.

This option is required on z/OS. In all other environments, JSCOM3 is the
recommended configuration option.

Configuring Db2 Web Query
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Reporting Server JSCOM. Directs output to the JSCOM3 listener on the Reporting
Server, which will then render the output in graph image file format. The URL used by
this setting is the URL of the JSCOM3 listener. Use this option if you need to support
SSL or any type of authentication other than the default internal security.

Transin-Transout

Is a fully qualified Java class that does the transin and transout processing (processing of
a request to and output returned by the Reporting Server) for a plug-in for the Servlet
version of the client. This class must implement the WFTransInOutInterface Java class. For
example, one use of this class can be to enable data that is passed between the
Reporting Server and the Servlet to be parsed for bi-directionality (left/right versus right/
left strings). 

Plugin Class

Specifies the qualified name of a plug-in class to be invoked by the Db2 Web Query
Servlet. By default, this variable is set to ibi.webfoc.WFEXTDefault, which is the default
plug-in supplied with Dd2 Web Query that contains several useful functions. 

Reference: ESRI Settings

ESRI settings define the connection to the local application that supports Esri-based maps.

ESRI On Premise

Identifies the path to the internal ArcGIS JavaScript API Source used to develop Esri-based
maps for Web Query. This setting is blank, by default, meaning that the use of an internal
source is not activated. To activate the use of an internal ArcGIS JavaScript API to develop
Esri maps, type the path to it in this setting, typically, /web_resource/arcgis_api.

The default API that should be referenced by this setting is the ArcGIS API for JavaScript,
version 3.15, which can be found at https://js.arcgis.com/3.15/. The ArcGIS JavaScript API
zip file is available for download from https://developers.arcgis.com/downloads/.

For more information about the Esri ArcGIS Javascript API, see https://
developers.arcgis.com.

For more information about how to configure Esri On Premise for InfoAssist+, see the
Configuring an Esri On Premise Environment topic in the InfoAssist+ online Help.

1. Db2 Web Query Administration Console
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Reference: Other Settings

Other settings determine miscellaneous configuration settings.

Enable OLAP

Enables OLAP settings and functionality. When this check box is selected, OLAP
functionality appears in the following location: 

InfoAssist+. On the Auto Drill and Analysis menu: All OLAP-related features including
the OLAP Options panel, OLAP panel, OLAP Ribbon, and OLAP Reports.

This check box is not selected, by default.

Reference: Parameter Prompting Settings

Parameter Prompting settings determine parameter prompting behavior in Web Query.

Managed Reporting

Enables or disables parameter prompting for all Managed Reporting requests. Possible
values are:

Off. Turns off parameter prompting at the site level.

Run with Default Values (XMLRUN). Prompts for amper variables that were created
with the -DEFAULT command and any other amper variable that does not have a value.

Always Prompt (XMLPROMPT). Prompts for amper variables that were created with
the -DEFAULT command when there is another amper variable that does not have a
value assigned. This is the default value.

Managed Reporting when Prompt Parameters Property Unset

Enables or disables parameter prompting for Managed Reporting procedures (FEXes) when
Managed Reporting (IBIMR_PROMPTING) is set to Always Prompt (XMLPROMPT) or Run
with Default Values (XMLRUN), and the Prompt for Parameters check box is not selected in
the FEX Properties dialog box. Possible values are:

Off. Turns off parameter prompting.

Run with Default Values (XMLRUN). Prompts for amper variables that were created
with the -DEFAULT command and any other amper variable that does not have a value.
This is the default value.

Always Prompt (XMLPROMPT). Prompts for amper variables that were created with
the -DEFAULT command when there is another amper variable that does not have a
value assigned.

Configuring Db2 Web Query
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Self Service

Enables or disables amper auto prompting. Possible values are:

Off. Turns off auto prompting. This is the default value.

Run with Default Values (XMLRUN). Prompts for amper variables that were created
with the -DEFAULT command and for any other amper variable that does not have a
value.

Always Prompt (XMLPROMPT). Only prompts for amper variables that were created
with the -DEFAULT command when there is another amper variable that does not have a
value assigned and, therefore, will be prompted for.

Display XML (Debug with syntax error checking) (XML). Displays the XML document
describing the amper variables in the browser. This setting is used internally, and is
recommended for debugging and syntax error checking purposes only.

Display XML (Debug) (XMLCHECK). Displays the XML document describing the amper
variables in the browser. This setting is used internally, and is recommended for
debugging purposes only.

Note: Managed Reporting uses a separate variable setting, which is IBIMR_PROMPTING.

Default Autoprompt Template

Specifies the template that defines the layout of the autoprompt interface. 

Responsive. Specifies the use of the responsive implementation and the
autoprompt_jqm.jsp template. This is the default value.

HTML_Top. Specifies the use of the HTML-based implementation and the
autoprompt_top.html template, which displays parameters horizontally at the top of the
page.

HTML_Top_Checked. Specifies the use of the HTML-based implementation and the
autoprompt_top_checked.html template. In this template, the Run in a new window
check box is selected, specifying that all reports open in a new window, by default.

Null Behavior

Specifies the value (_FOC_NULL or FOC_NONE) that the client assigns to the amper
variable when the dynamic multi-select list No Selection value is selected. The default
value is _FOC_NULL. 

1. Db2 Web Query Administration Console
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Reference: Db2 Web Query Spreadsheet Client Settings

The Spreadsheet Client settings determine how Spreadsheet Client performs authentication.

Security

Specifies the type of sign in used by Db2 Web Query Spreadsheet Client. Permitted values
are Reporting Server and Managed Reporting. The default value is Managed Reporting (MR)
and should not be changed. 

Form Only

Applies when MR authentication is selected for the Security setting. Permitted values are:

Yes. Users may not create their own reports using InfoAssist+, but may only use
predefined ad hoc forms.

No. Users may use predefined ad hoc forms or create their own reports, using
InfoAssist+. The default value is No (clear check box).

Reference: Security

Security settings govern authentication for the Web Query environment.

Enable Password Change

Allows users to change their Web Query user ID password. The default is selected.

Sign-out URL

Defines the URL to which a user ID is redirected to on sign out of Db2 Web Query. The
default is /, which redirects the user to the Db2 Web Query Sign in page.

For Kerberos configurations, set the URL to logon/logoff.jsp or to another preferred URL,
rather than the default of /.

Changing Web Query Client Settings in Web Query

The client configuration settings are grouped into categories under the Configuration menu in
the Administration Console. The term Initial Value next to a setting means that the value shown
initially is the installation default value and that it can be overridden by setting the variable
explicitly in the URL request.

Understanding Custom Settings

The Custom Settings page allows you to customize your installation of Web Query by typing
customized values for standard settings.

Changing Web Query Client Settings in Web Query
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When you save updates to settings that you type into the Customized Setting text box, they are
transferred to the site.wfs file, located in the /qibm/UserData/qwebqry/base80/
client/wfc/etc directory. When you use this page to assign new values to settings, they
override the default values assigned to them. These overrides are carried over as you upgrade
to new versions.

After you save a custom setting, the text continues to display on this page. You can use
comments to identify specific updates and additional information about them.

Procedure: How to Configure Custom Settings

Only an administrator can configure settings on the Custom Settings page.

1. In the Administration Console, on the Configuration tab, click Custom Settings.

2. Under the final comment statement at the top of the Custom Settings text box, or the
most recent custom setting entry, type the variables, settings, commands, or comments
that comprise the custom settings.

Use the format required by the application or operating system that will execute the
command.

To help track changes to custom settings, use comments to identify and separate
individual changes.

3. To store your custom settings in an encrypted format, select the Encrypt check box.

Note: Even when you select this check box, settings continue to appear in an unencrypted
format in the Custom Settings text box.

4. When your configuration is complete, click Save.

5. When you receive a confirmation message, click OK.

6. When the Custom Setting page clears, click Custom Settings under the Application
Settings folder to see your updated comments, settings, or commands in the Custom
Settings text box.

Customizing the Dynamic Language Switch

You can customize the languages that are made available on Sign in pages by activating the
Dynamic Language Switch.

Procedure: How to Customize the Dynamic Language Switch

1. In the Administration Console, on the Configuration tab, under the Application Settings
folder, click Dynamic Language Switch.

1. Db2 Web Query Administration Console
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The Dynamic Language Switch page opens with a list of the languages made available by
the code page selection in the National Language Support page. By default, the Enable
Dynamic Language check box is not selected and all of the language check boxes are
deactivated.

2. Select the Enable Dynamic Language check box to activate the check boxes for all of the
available languages displayed in the panel, as shown in the following image.

Selecting the Enable Dynamic Language check box and one or more languages activates
the display of the Language menu on all of the Sign in pages.

3. Select the check box next to each of the languages that you want to appear on the Sign in
pages and in the Language menu.

4. Select the check box in the Locale heading if you want all of the languages to appear in
the Language menu on the Sign in pages.

5. Click Save.

6. When you receive the Successfully Saved message, click OK.

Note: To remove languages from the Language menu on the Sign in pages, clear the check
boxes next to the languages you want to remove.

Understanding Redirection Settings

You can view or edit redirection settings for the Db2 Web Query Client though the Redirection
Settings page of the Administration Console. However, you should not alter Redirection
Settings without consulting Support. 

Changing Web Query Client Settings in Web Query
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Redirection settings allow users to save report output in a temporary directory when a request
is executed. Then, the browser makes an HTTP call to retrieve the temporary stored output for
display.

If redirection is turned off, the report output displays in the browser immediately after the
request is executed.

To change redirection settings in the Administration Console, on the Configuration tab, click
Redirection Settings. The Redirection Settings panel opens, as shown in the following image.

Procedure: How to Change Redirection Settings

1. In the Administration Console, on the Configuration tab, click Redirection Settings.

2. In the Redirect column, select yes on a row to redirect the output to a temporary directory
for the specified extension.

3. In the Save Report column, select yes to prompt users in the browser to open or save
report output. When Save Report is set to yes, the report output retains the Save As
name, if specified in the request.

1. Db2 Web Query Administration Console
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For example, specifying ON TABLE PCHOLD AS MYREPORT FORMAT PDF in a request and
setting Save Report to yes for the .pdf extension enables a user to open or save the
output as MYREPORT.pdf. The Save As name specified is returned to the browser in
uppercase. If Save Report is set to yes and no Save As name is specified in the request, a
random file name is generated.

Important: You must do the following to use the Save Report functionality for GRAPH
requests (specified with a PNG, SVG, GIF, JPEG, or JPG format in the procedure):

Set Save Report to yes for the .htm Extension.

Running a server-side GRAPH request creates an HTM file that contains a link to the
actual graph output, which is stored as a temporary image file with
a .jpeg, .jpg, .gif, .svg, or .png extension.

When you execute a GRAPH request, if you select the Save option when prompted to
open or save the output, the output is saved to an HTM file using only a reference to
the graph image, which will eventually expire and be deleted from the server (according
to the temporary file expiration settings in the Client Configuration).

To preserve the output of the GRAPH request, open the saved HTM file, right-click the
graph image, and select Save Picture As to save it to disk permanently. You can then
substitute an absolute reference to the saved image file in the returned HTM output
file.

4. If you want to encrypt the redirection settings, select the Encrypt check box at the bottom
of the screen.

5. Click Save to save your changes in the Redirection Settings panel.

InfoAssist+ Properties

Settings in the InfoAssist+ Properties page of the Administration Console determine the
display and use of features in the InfoAssist+ tool that opens when creating or updating
content.

To open the InfoAssist+ Properties page, in the Administration Console, scroll down to the
bottom of the Configuration tab menu, and then click InfoAssist+ Properties. You can then
enable or disable options for the InfoAssist+ tool. 

Changing Web Query Client Settings in Web Query
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Reference: Understanding InfoAssist+ Home Tab Properties

The InfoAssist+ Home tab enables you to control the most commonly used properties and
options from the Home tab. These properties are:

Use Live Preview Mode

Determines whether InfoAssist+ opens in the Live Preview mode or the Query Design View,
by default. When Yes is selected, InfoAssist+ opens in the Live Preview mode as the
default. When Yes is not selected, InfoAssist+ starts with the Query Design View. If the
Allow User Override check box is selected for this option, users can change the setting
specified by the administrator.

Record Limit

Enables the Record Limit menu of the Home tab. If Show is not selected, the Record Limit
menu is removed from the InfoAssist+ interface.

Themes

Provides InfoAssist+ users with various color-coded StyleSheet themes that can be used to
style reports and charts. Users can select standard InfoAssist+ themes, or select
customized cascading style sheet themes created by your organization.

Page Heading

Enables the Header & Footer menu of the Home tab. InfoAssist+ users can use this menu
to add a heading or footing to each page of the report output.

Report Heading

Enables the Header & Footer menu of the Home tab. InfoAssist+ users can use this menu
to add a heading or footing to the first page of the report output.

Reference: Understanding InfoAssist+ Format Tab Properties

For reports or charts, InfoAssist+ displays a list of output file format options, such as HTML,
PDF, or Excel, in the Format Group of the Home tab. Other options that make additional layouts
and display features available when creating a report or chart appear on the Format tab itself.
You can control the display of both types of options through the settings contained in this
section.

Note: Settings in this section do not affect the display of Format tab features for
visualizations.

Active PDF Format

Enables the use of the active PDF report format. The active PDF format adds portability and
interactive enhancements to active reports in PDF format.

1. Db2 Web Query Administration Console
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When this check box is selected, this output format option is available for use when
selected from the Output Format drop-down menus in the Tool Options Dialog Defaults
section of the InfoAssist+ Properties page.

Active Report Format 

Enables the use of the HTML active report format. An HTML active report is a self-
contained report that is designed for offline analysis. It contains all of the data and
JavaScript within the HTML output file and it includes analysis options, such as filtering,
sorting, and charting.

When this check box is selected, this output format option is available for use when
selected from the Output Format drop-down menus in the Tool Options Dialog Defaults
section of the InfoAssist+ Properties page.

Additional HTML Formats for Chart

Enables the use of the PNG, JPEG, GIF, and SVG output formats. The default value is PNG.
PNG is not available as a format for chart output.

Additional PDF Formats for Chart

Enables the use of the PDF/SVG and PDF/GIF output formats. The default value is PDF/
SVG.

Excel 2000 Format

Enables the use of the Excel 2000 spreadsheet output format. The Excel 2000 format
supports most StyleSheet attributes, allowing for full report formatting. The computer on
which the report displays must have Microsoft Excel 2000 installed.

When this check box is selected, this output format option is available for use when
selected from the Output Format drop-down menus in the Tool Options Dialog Defaults
section.

This check box is selected, by default.

Excel 2000 Formula

Enables the use of the Excel 2000 formulas when the Excel 2000 Format option is
selected.

This check box is selected, by default.

Excel 2007 Format

Enables the use of the Excel 2007 spreadsheet output format. The computer on which the
report displays must have Microsoft Excel 2007 installed.

Changing Web Query Client Settings in Web Query
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When this check box is selected, this output format option is available for use when
selected from the Output Format drop-down menus in the Tool Options Dialog Defaults
section of the InfoAssist+ Properties page.

This check box is selected, by default.

Excel 2007 Formula

Enables the use of the Excel 2007 formulas when the Excel 2007 Format check box is
selected.

This check box is selected, by default.

Excel Pivot

Enables the use of the Excel 2000 PivotTable output format. PivotTable is an Excel tool for
analyzing complex data.

This check box is not selected, by default.

HTML Format

Enables the use of the HTML page report format.

When this check box is selected, this output format option is available for use when
selected from the Output Format drop-down menus in the Tool Options Dialog Defaults
section of the InfoAssist+ Properties page.

InfoMini Run Immediate

If Enable is selected, reports run immediately when InfoMini first launches. This setting is
enabled, by default.

Other Chart Types

Allows the creation of more complex graph output types, such as spectral maps, gauge
charts, and Pareto charts.

Pages on Demand

Enables the display of report output one page at a time. InfoAssist+ users can use the
navigation menu at the bottom of the output screen to view each page. This option is
activated only when HTML or active report output format is selected.

PDF Format

Enables the use of the PDF report format.

When this check box is selected, this output format option is available for use when
selected from the Output Format drop-down menus in the Tool Options Dialog Defaults
section of the InfoAssist+ Properties page.

1. Db2 Web Query Administration Console
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PowerPoint 2000 Format

Enables the use of the PowerPoint® 2000 document output format. The computer on
which the report appears must have Microsoft PowerPoint 2000 or higher installed.

When this check box is selected, this output format option is available for use when
selected from the Output Format drop-down menus in the Tool Options Dialog Defaults
section of the InfoAssist+ Properties page.

PowerPoint 2007 Format

Enables the use of the PowerPoint® 2007 document output format. The computer on
which the report appears must have Microsoft PowerPoint 2007 or higher installed.

When this check box is selected, this output format option is available for use when
selected from the Output Format drop-down menus in the Tool Options Dialog Defaults
section of the InfoAssist+ Properties page.

Stack Measures

Displays all numeric measure field names in the first column of the report output, with the
corresponding numeric data values displayed across time in a column for each selected
time period. The Stack Measures feature is activated only when HTML, Excel, or
PowerPoint output format is selected.

User Selection

Allows users to change the output type of their reports at run time.

Reference: Understanding InfoAssist+ View Tab Properties

Enables InfoAssist+ users to customize the view of different report components in the
InfoAssist+ tool, such as the design mode, output location, and data view. You can configure
the following properties in the InfoAssist+ View tab:

Display View Tab

Enables the View tab and all of its menu options. If this is not selected, the View tab is
removed from the InfoAssist+ interface.

Data Panel 

Allows the user to customize Data Panel settings. Values are Logical (default), List, and
Structured.

Changing Web Query Client Settings in Web Query

20  IBM



Query Panel

Allows the user to customize the view of the query components, such as Filters, Column
and Row labels, and Measures when building a report. Values are Tree (default), Area 2x2
(2 columns by 2 rows), Area 1x4 (1 column by 4 rows). If the Allow User Override check box
is selected for this option, users can change the setting specified by the administrator.

Reference: Understanding InfoAssist+ Tool Options Dialog Defaults Properties

Settings in the Tool Options Dialog Default section enable administrators to specify default
tool settings. If the Allow User Override check box is selected for an option, users can change
the setting specified by the administrator. However, the administrator cannot specify a default
value that has already been disabled in one of the other groups. For example, if you have
disabled the active PDF format (APDF) in the Format Tab section, you will see an error
message if you attempt to set that format as a default Compose Output Format in the Dialog
Defaults section.

Report Output Format

Sets the default format for reports. Valid values are HTML, active report, PDF, active PDF,
EXL07, EXL2K, PowerPoint 2000, and PowerPoint 2007. The format options in this list are
available only when their corresponding check box is selected in the Format Tab section of
the InfoAssist+ Properties page. If that check box is cleared, you will receive a message
warning you that the format option is not enabled when you select it from this list. The
default value is HTML.

Chart Output Format

Sets the default format for charts. Valid values are HTML, HTML5, active report, PDF,
active PDF, EXL07, EXL2K, PowerPoint 2000, and PowerPoint 2007. The format options in
this list are available only when their corresponding check box is selected in the Format
Tab section of the InfoAssist+ Properties page. If that check box is cleared, you will receive
a message warning you that the format option is not enabled when you select it from this
list. The default value is HTML5.

Document Output Format

Sets the default format for documents that are generated in InfoAssist+. Valid values are
HTML, active report, PDF, active PDF, EXL07, EXL2K, PowerPoint 2000, and PowerPoint
2007. The format options in this list are available only when their corresponding check box
is selected in the Format Tab section of the InfoAssist+ Properties page. If that check box
is cleared, you will receive a message warning you that the format option is not enabled
when you select it from this list. The default value is PDF.
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Page Orientation

Sets the default page orientation for reports and charts. Valid values are Portrait and
Landscape. The default value is Portrait. If the Allow User Override check box is selected for
this option, users can change the setting specified by the administrator.

Page Size

Sets the default page size for reports and charts. Valid values are A3, A4, A5, Letter,
Tabloid, Legal, PPT-SLIDE, and Large Size. The default value is Letter. If the Allow User
Override check box is selected for this option, users can change the setting specified by
the administrator.

Data Preview Method

Sets the default action for whether reports are previewed using sample data or actual data
from the data source. Valid values are Live and Sample. The default value is Live. If the
Allow User Override check box is selected for this option, users can change the setting
specified by the administrator.

Record Limit

Sets the default maximum number of rows retrieved from the data source when Interactive
Design view is selected. This feature is useful in reducing response time if users are
working with a large amount of data. It is applicable only when developing the report. The
record limit setting will not affect the report output at run time. Valid values are, All, 1, 10,
50, 100, 500, 1000, 2000, 5000, 10000 rows. The default value is 500 rows. If the Allow
User Override check box is selected for this option, users can change the setting specified
by the administrator.

Output Target

Sets the default location for reports and charts. Valid values are Single tab, New tab,
Single window, and New window. The default value is Single tab. If the Allow User Override
check box is selected for this option, users can change the setting specified by the
administrator.

InfoAssist+/Portal StyleSheet

Sets the StyleSheet to be used for InfoAssist+ and the Portal. Click Change Stylesheet to
open the Browse predefined template files window. The value displayed, by default, is
Warm.sty.

If the Allow User Override check box is selected for this option, users can change the
setting specified by the administrator.
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Visualization StyleSheet

Sets the StyleSheet to be used when creating visualizations. Click Change Stylesheet to
open the Browse predefined template files window. The value displayed, by default, is
Warm.sty.

If the Allow User Override check box is selected for this option, users can change the
setting specified by the administrator.

Encode HTML

Encodes script tags within data, so that the tags are replaced and not executable in a
browser. The default value is Yes. This includes the ON TABLE SET HTMLENCODE ON
command in the procedure.

Enable Pages On Demand

Allows InfoAssist+ users to view report output one page at a time. The user can use the
navigation menu at the bottom of the output screen to view each page. This option is
activated only when HTML or active report output format is selected.

Rows retrieved from cache

Establishes how many rows of cached data stored in a binary file are returned to the
output window at one time. The default value is 100 rows.

Reference: Understanding InfoAssist+ File Options

Determines which of the following file types can be selected by InfoAssist+ users when
creating and saving HOLD files:

Binary

Stores report or chart data as binary numbers in numeric fields. Binary files use the
extension (*.ftm).

FOCUS

Stores report or chart data as text in a segment structure that conforms to FOCUS
database requirements. FOCUS files use the extension (*.foc).

Comma Delimited with Titles

Stores report or chart data as text in sequence by field. Alphanumeric fields are enclosed
in quotation marks. Fields are separated by commas and are preceded by Field Names.
Comma Delimited with Titles files use the extension (*.csv) (Comma Separated Values).

Plain Text

Stores report or chart data as text in sequence by field without delimiters or field names.
Plain Text files use the extension (*.ftm).
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Tab Delimited

Stores report or chart data as text in sequence by field. Fields are separated by tab
characters. Tab Delimited files use the extension (*.tab).

Tab Delimited with Titles

Stores report or chart data as text in sequence by field. Fields are separated by tab
characters, and are preceded with field names. Tab Delimited with Titles files use the
extension (*.tab).

Database Table

Stores report or chart data as text in a field structure that conforms to a Structured Query
Language (SQL) Database format. Database Table files use the extension (*.sql).

Database Table output is only available when working against an SQL database.

Hyperstage

Stores report or chart data as text in a field structure that conforms to the Hyperstage
database table format. Hyperstage files use the extension (*.bht).

Hyperstage output is only available when the Reporting Server has a Hyperstage adapter
configuration.

SQL script

Stores report or chart data as text in a sequential field structure that can be imported into
a database table that conforms to the Structured Query Language (SQL) Database format.
SQL Script files use the extension (*.sql).

SQL Script output is only available when working against an SQL database.

XML

Stores report or chart data as text in a field structure that conforms to the rules of the
Extensible Markup Language. Fields are separated by tags that identify content. XML files
use the extension (*.xml).

JSON

Stores report or chart data as text in a structure that conforms to the rules of JavaScript
Object Notations. JSON files use the extension (*.json).
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Reference: Understanding InfoAssist+ Chart Type Options

Leaflet Maps

Enables the icons required for the use of Leaflet maps in both chart and visualization
mode of InfoAssist+. The two Leaflet map icons enable you to select either a Choropleth or
a Proportional Symbol (Bubble) map based on the Leaflet open-source JavaScript library for
mobile-friendly interactive maps.

In chart mode, these icons are available in the Select a chart dialog box. To open this
dialog box, click Other on the Format tab, in the Chart Types group. In the Select a chart
dialog box, click Map.

In visualization mode, these icons are available in the Select a Visual dialog box. To open
this dialog box, click Change on the Home tab, in the Visual group.

If this setting is not selected, Leaflet map icons do not appear in either location. The
default value is selected.

Reference: Understanding InfoAssist+ Auto Drill Properties

Settings in this section enable the use of drill-down navigation options, which are part of the
Auto Drill functionality.

Single Click Navigate

Enables the use of single click navigation, which is an automatic drill down to the next
level of a dimension within the body of a report or chart made in response to a single click
on a top-level entry or feature.

By default, this check box is not selected, meaning that single click navigation is disabled,
and top-level Auto Drill entries or features display the Drilldown menu in response to a
single click. If this check box is selected, single click navigation is enabled, and instead of
displaying the Drilldown menu, top-level Auto Drill entries or features automatically refresh
the report or chart with results based on the next lower level of your selected dimension in
response to a single click.

Breadcrumbs

Enables the display of a breadcrumb trail at the top of an Auto Drill report or chart.

By default, this check box is selected, and Auto Drill reports and charts display a
breadcrumb trail. If this check box is cleared, Auto Drill reports and charts do not display a
breadcrumb trail.

In an Auto Drill report or chart, a breadcrumb trail displays a series of links to previous
versions that were generated as you drilled through each level of your selected dimension
to reach the version currently on display.
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Restore Original

Enables the display of the Restore Original option in the Drilldown menu.

By default, this check box is selected, and the Restore Original option appears in the
Drilldown menu. If this check box is cleared, the Restore Original option does not appear in
the Drilldown menu.

In an Auto Drill report or chart, the Restore Original option returns you directly to the
original version.

Drill Up

Enables the display of the Drill up option in the Drilldown menu.

By default, this check box is selected, and the Drill up option appears in the Drilldown
menu. If this check box is cleared, the Drill up option does not appear in the Drilldown
menu.

In an Auto Drill report or chart, the selection of the Drill up option refreshes the display
with results based on the next level above the current level of your selected dimension.

Drill Down

Enables the display of the Drill down option in the Drilldown menu.

By default, this check box is selected, and the Drill down option appears in the Drilldown
menu. If this check box is cleared, the Drill down option does not appear in the Drilldown
menu.

In an Auto Drill report or chart, the selection of the Drill down option refreshes the display
with results based on the next level below the current level of your selected dimension.

Note: In addition to disabling the Drill down option, clearing this setting also removes
hyperlinks from top level report entries and the breadcrumb trail display from reports and
charts. If the Single Click Navigate setting is also cleared, clearing the Drill Down setting
effectively disables Auto Drill navigation tools in reports and charts that contain only the
top level of a dimension value in their design. If the Single Click Navigate setting is
selected, and the report or chart contains entries below the top level, clearing the Drill
Down setting shifts the Single Click Navigation feature to those lower-level entries.
However, because this setting also suppresses the display of the Drilldown menu, users
will neither be able to restore the original version of the report or chart, nor will they be
able to drill back up to a higher level.
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Reference: Understanding InfoAssist+ Miscellaneous Options

Use two-part file name

If selected, this option requires the use of two-part file names, which specify the path to
the Master File location. If not selected, a one-part file name must be used instead. The
default value is selected.

Expand Data Source Tree

Determines whether the initial view of the data source tree is expanded or collapsed. If
selected, the tree is expanded. If not selected, the tree is collapsed. The default value is
selected.

Join Tool

Displays the Join menu option on the InfoAssist+ Data tab. If not selected, the Join menu
option is removed from the Data tab. The default value is selected.

Layout Tab

Enables the Layout tab in the InfoAssist+ ribbon. If not selected, the Layout tab is removed
from the InfoAssist+ ribbon. The default value is selected.

Series Tab

Enables the Series tab in the InfoAssist+ ribbon. The Series tab displays when working
with charts and visualizations. It provides access to charting properties and options in the
Properties, Line, and Pie menus. If not selected, the Series tab is removed from the
InfoAssist+ ribbon. The default value is selected.
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Working With HTML5 Chart Extensions

The HTML5 Chart Extensions page contains all HTLM5 chart extensions currently installed in
your local installation of Web Query, as shown in the following image. 

HTML5 chart extensions expand the standard set of InfoAssist+ charts to include customized
charts tailored to very specific reporting and data visualization requirements.

Features on this page allow you to upload HTML5 chart extensions, enable or disable their use
in InfoAssist+, and uninstall them from Web Query when no longer needed.

Understanding HTML5 Chart Extension Entries

Each HTML5 Chart Extension entry contains details that identify a chart extension and its
origin, and help you determine if a chart extension is appropriate for your installation of Web
Query.
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Each entry identifies an HTML5 chart extension with a Name, Description, Version, and API
Version. These details help you identify the chart extension you want to use, and the specific
version of it that best matches your requirements. The Author and Copyright identify the origin
of the chart extension, and the URL links you to the location where you can retrieve additional
copies. License information identifies the type of license, if any, under which the chart
extension is made available to you, and helps you understand any limits on the use of the
chart extension and the rights and obligations licensed users have to the developer.

Understanding the HTML5 Chart Extensions Enable/Enabled Check Box

Every HTML5 Chart Extension entry includes the Enable/Enabled check box that indicates
whether or not the chart extension is available for use. The use of this check box provides
administrators with a second level of availability that enables them to restrict the full
availability of HTML5 Chart Extensions to those that are in active use, while retaining all other
installed HTML5 Chart Extensions in readiness for when they are needed.

When this check box is cleared, it displays the Enable label to indicate that selecting the check
box will make the chart extension available for use, as shown in the following image.

HTML5 Chart Extensions that have the Enable check box selected are installed, but they are
not available to users in Web Query or InfoAssist+.

When this check box is selected, it displays the Enabled label to indicate that the chart is
already available for use, as shown in the following image.

HTML5 Chart Extensions that have the Enabled check box selected are installed and are
available to developers using InfoAssist+ for their use in chart creation. Web Query identifies
the files and directories included in that Chart Extension as eligible for calls from InfoAssist+,
and displays an icon for that Chart Extension in the Select a Chart menu that opens from the
Other command in the Chart Type group, on the InfoAssist+ Format tab ribbon.
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Note: The HTML5 Chart Extensions page does not manage copyright or license restrictions.
You are ultimately responsible for the use of any HTML5 Chart Extension you upload.
Therefore, you must ensure that you have a license or permission to use any HTML5 Chart
Extension before uploading it to this page.

Uploading Additional HTML5 Chart Extensions Using the Upload and Install Extension Page

Use the Upload and Install Extension page to install additional HTML5 Chart Extensions. To
open the Upload and Install Extension page from the main HTML5 Chart Extensions page, click
Get more Extensions, as shown in the following image.

The Upload and Install Extension page opens, as shown in the following image.

The Upload and Install Extension page provides two ways to install additional HTML5 Chart
Extensions:

By clicking the Install Extension button  in entries for chart extensions that are found
on the Information Builders public extension GitHub page, https://github.com/ibi/wf-
extensions-chart, but are not currently installed in your installation of Web Query.
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By clicking the Browse button  next to Upload and Install Extension field to
navigate to a folder on your local file system that contains a locally-developed HTML5 Chart
Extension package in .zip file format.

To move back to the main HTML5 Chart Extensions page from the Upload and Install Extension
page, click HTML Chart Extensions under the Application Settings folder, or click the Back
button in your browser.

Procedure: How to Upload HTML5 Chart Extensions from the Local File System

Use this procedure to upload zip files containing HTML5 Chart Extensions from your local
system.

You must ensure that you have a license or permission to use any HTML5 Chart Extension
before uploading it to this page.

1. Sign in as an administrator and open the Administration Console.

2. On the Configuration tab, under the Application Settings folder, click HTML5 Chart
Extensions.

3. On the HTML5 Chart Extensions page, click Get more Extensions.

4. On the Upload and Install Extension page, click Browse.

The Open dialog box opens and points to the extensions folder for your local Web Query
installation.

5. Click the file containing the zipped version of the HTLM5 Chart extension you want to
upload, and then click Open.

6. When the HTML5 Chart Extensions page refreshes and returns you to the top, scroll down
to the entry for the new HTML5 Chart Extension.

Procedure: How to Install HTML5 Chart Extensions From the IBI GitHub Page

Use this procedure to upload HTML5 Chart Extensions from the public IBI GitHub extension
page, https://github.com/ibi/wf-extensions-chart.

1. Sign in as an administrator and open the Administration Console.

2. On the Configuration tab, under the Application Settings folder, click HTML5 Chart
Extensions.

3. On the HTML5 Chart Extensions page, click Get more Extensions.
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4. On the Upload and Install Extension page, review the list of extensions from GitHub that
are not installed, as shown in the following image.

5. If the chart extension you want to install appears in the list, click Install Extension .

6. When the HTML5 Chart Extensions page refreshes and returns you to the top, scroll back
to your entry to confirm that the chart extension is now installed.

Procedure: How to Enable an Installed HTML5 Chart Extension

When you select the Enable check box in an HTML5 Chart Extension entry, you make it
available for use in InfoAssist+ and in your local installation of Web Query. You must ensure
that you have a license or permission to use any HTML5 Chart Extension before making it
available for use.

1. Sign in as an administrator and open the Administration Console.

2. On the Configuration tab, under the Application Settings folder, click HTML5 Chart
Extensions.

3. On the HTML5 Chart Extensions page, scroll to the entry for the HTML5 Chart Extension
that you want to enable.

Note: You can also search for the chart extension by name, using the Find or Find on this
page command that is supported by the browser.

4. Select the Enable check box, as shown in the following image.

5. When the HTML5 Chart Extensions page refreshes and returns you to the top, scroll back
to your entry to confirm that the check box is now selected.
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An icon for the HTML5 Chart Extension appears in the InfoAssist+ Select a Chart menu,
which opens when you click the Other command in the Chart Types group on the Format
tab.

Procedure: How to Disable an HTML5 Chart Extension

When you clear the Enabled check box in an HTML5 Chart Extension entry, you make it
unavailable for use in InfoAssist+ and in your local installation of Web Query. However, the
chart extension remains installed on the HTML5 Chart Extension page and can be enabled
again when needed.

1. Sign in as an administrator and open the Administration Console.

2. On the Configuration tab, under the Application Settings folder, click HTML5 Chart
Extensions.

3. On the HTML5 Chart Extensions page, scroll to the entry for the HTML5 Chart Extension
that you want to make unavailable.

Note: You can also search for the chart extension by name, using the Find or Find on this
page command that is supported by the browser.

4. Clear the Enabled check box, as shown in the following image.

5. When the HTML5 Chart Extensions page refreshes and returns you to the top, scroll back
to your entry to confirm that the check box is now cleared.

The icon for the HTML5 Chart Extension no longer appears in the in the Select a Chart
Menu that opens from the InfoAssist+ ribbon.

Procedure: How to Uninstall an HTML5 Chart Extension

1. Sign in as an administrator and open the Administration Console.

2. On the Configuration tab, under the Application Settings folder, click HTML5 Chart
Extensions.

3. On the HTML5 Chart Extensions page, scroll to the entry for the HTML5 Chart Extension
that you want to uninstall.

Note: You can also search for the chart extension by name, using the Find or Find on this
page command that is supported by the browser.
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4. Click Delete_CHARTNAME_ Chart, as shown in the following image.

5. When you receive a message asking if you want to permanently delete the extension, click
Yes.

6. When the HTML5 Chart Extensions page refreshes and returns you to the top, scroll back
to your entry to confirm that the entry is now deleted.

The entry for the HTML5 Chart Extension no longer appears on the page. If the HTML5
Chart Extension was installed from the GitHub page, it now appears on the Upload and
Install Extension page and can be reinstalled from that page. If it was installed from your
local file system, it does not appear on that page, and you will be required to use the
Upload and Install Extension field and Browse button to reload the chart extension from
your local file system.
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Chapter2
Db2 Web Query Change Management

Change management is the process of moving application components between Db2
Web Query environments of the same release level. Typically, this is done to ensure that
applications have been fully tested, prior to deploying to a production environment.

There are features and methodologies within Db2 Web Query, which are used to facilitate
these important tasks.

In this chapter:

Understanding the Change Management Process

Creating a Change Management Package

Understanding the Change Management Process

Developing an application is an iterative process. Developers revise application code and
periodically move these components to the test environment for user feedback and
acceptance. At some point within the application development lifecycle, when the application is
stabilized, it is moved to production. After an application is released for general use, problems
must be fixed, tested, and incorporated into the production environment. This is the essence
of the change management process, which is also referred to as production control.

Organizations vary widely in how they approach change management. Some delegate much of
the responsibility to developers, while others establish alternative processes to maintain a
higher degree of control. Typically, developers utilize development tools to perform these
duties, while change management professionals prefer batch-oriented methods to move
application components between environments. Developers may be required to create a
change management package in order to initiate changes after the application is moved to
production. A combination of these approaches is often used in larger companies.

The examples that follow illustrate two different change management processes. These
sections describe product features and methodologies that can be utilized by companies to
meet their change management objectives with DB2 Web Query.
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Example: Moving Application Files: A Simple Change Management Process

Developers move application files between the development and test environments using their
development tool, as shown in the following image. When the application is finished, the
application is copied from the test environment to the production environment, using operating
system utilities. There may only be a single test environment.

Example: Moving Application Files: A Comprehensive Change Management Process

In this example, four DB2 Web Query environments are established to increase the level of
control of moving application code to production. Developers use the BI Portal Resources tree
or Developer Workbench to move application files from the development environment to the
test environment. Developers then use the Change Management Export facility when they are
ready to move their changes to the user acceptance test environment.
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The Change Management Export facility allows the Developer to select the resources to be
moved and creates a change management package. An administrator can subsequently move
the change management package into an acceptance test using the Change Management
Import facility. Some organizations may choose to utilize an automated process to import the
content, to achieve better integration with their business processes. As shown in the following
image, when the application is deemed ready for release, the production control personnel
initiates a file system copy of the application to the production environment. Users begin using
the application and the change management process shifts into an application maintenance
support role. From this point forward, incremental updates to production are facilitated by
administrators using the Change Management Import facility.

Creating a Change Management Package

Many organizations do not grant developers write access to the user acceptance test and
production environments. Access to these environments is strictly controlled and granted only
to administrators, production control personnel, or automated change management processes.

Only developers know which changes are ready to be moved into test. The Change
Management Export facility presents developers with a graphical view of the resources they
manage and allows them to build a change management package. This package is then loaded
into another environment by production control personnel or automated processes.

Procedure: How to Create a Change Management Extract Package

A user must be a Web Query developer or administrator to create a Change Management
Export Package.

The steps required for creating a Change Management Package are:

1. Creating a Scenario. Using the Change Management Export user interface, create a
Change Management scenario by selecting the resources to be exported. A scenario is a
description of all the resources that will be exported into a Change Management Export
Package.
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2. Exporting a Scenario. After creating a scenario, export it into a Change Management
Export Package. This Change Management Export Package is placed in the directory with
the same name as the scenario:

/qibm/userdata/qwebqry/base80/cm/export

The exported folder is then copied to the target environment and placed in this directory:

/qibm/userdata/qwebqry/base80/cm/import

Note: The Change Management Export and Import activity is written to the following log
file:

/qibm/userdata/qwebqry/base80/logs/impex.log

Procedure: How to Access the Change Management Export Facility to Create a Scenario

1. Right-click Export in the Change Management section, and select New Scenario, as shown
in the following image.

2. In the New Scenario dialog box, type the Scenario name, and then click OK.

This will invoke the user interface to create the Scenario, which allows a user to select
Resources that will be moved to the target system.

There are two major options listed on the top of the Change Management Export Interface.

With Rules. Unselected by default. This option should not be selected.
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Retain Handles. This option is necessary when a release 2.1.x or 2.2.x source
environment is migrated from a 1.1.x release of DB2 Web Query, and this content is used
in a Change Management process. During migration from release 1.1.x to release 2.1.x or
2.2.x, the 1.1.x release hrefs are used as the 2.1.x or 2.2.x release handles to allow the
earlier code for –INCLUDEs and drill downs to continue to work with the release 1.1.x style
syntax. Moving these handles to the target environment, will allow code that contained the
earlier style –INCLUDE and drill down syntax to continue to work.

The following types of resources can be moved:

Any folder or item from the /WFC/Repository or what is shown in the user interface as
DB2 Web Query, including procedures (FOCEXECs), Stylesheets, Images, HTML files,
Schedules, and Distribution Lists.

Any application or specific files from the Reporting Server node on the tree.

Selecting Resources

Resources are selected by either dragging content from the Change Management tree
on the left, to the right pane. Or, using the context menu and right-selecting the
content you want to move, and choosing either Select With Subtree or Select Folder
Only.

Select With Sub-tree selects that folder and all subfolders.

Select Folder Only selects the specific folder, with no content. Typically, that is
done to move rules on the folder.

When your selection is complete, an entry for it appears in the right pane, and a
strikethrough line appears on the entry under the Resources tree.

If you select a private resource, the With Private Content check box is automatically
selected and cannot be cleared.

If you select private content, it will only be imported if the owner of that private content
already exists in the target environment.

If you select a published folder, you can include private content within it by selecting
the With Private Content check box for that resource. This selection exports all of the
private content in that folder and its subfolders, including those My Content folders
that are assigned to individual users, even if you do not have the privileges necessary
to view that private content.

If you select a subfolder without a parent folder, the Import process will recreate the
parent folder in the target environment. A connection to the same metadata must exist
within the target environment as well as the source environment.
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When selecting a collaborative portal and pages that reference external content, be
sure to include that content in the change management package.

If the rules on the source and target environments are different, users may have
access to private content in the source environment, but be denied access in the
target environment. This occurs if users have access to the published folder that
contains the private content in the source environment, but do not have it in the target
environment.

Selecting a folder

3. Now that resources are selected, the Scenario should be saved.

Once saved, the Scenario can be run through the Change Management Import interface.

Creating a Change Management Package
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Procedure: How to Download a Change Management Package Zip File

The export process saves a CM zip file to /qibm/userdata/qwebqry/base80/cm/export. The
download process takes that CM zip file, and downloads it to your local machine. You can then
transfer the copy of that CM zip file to another Web Query environment for use as a change
management package.

1. In the Resources tree, expand the Change Management node.

2. Expand the Export node.

3. Right-click the CM zip file you want to download, and then click Download, as shown in the
following image.

4. Save the CM zip file to an external location as directed by your browser.

Procedure: How to Upload a Change Management Package Zip File

The zip file upload process saves a copy of a CM zip file stored on your local machine to the
change management import directory on the server, /qibm/userdata/qwebqry/base80/cm/
export. You can then import the copy of that CM zip file to Web Query.

1. In the Resources tree, expand the Change Management node, right-click Import, and then
click Upload a Zip File, as shown in the following image.

2. In the Upload a Zip File dialog box, click Browse, navigate to the location where you have
saved the change management package, click the CM zip file you want to upload, and then
click Open.

3. Ensure that the correct CM zip file appears in the File to Upload field, and decide whether
or not to import files from the package as published or unpublished files.

To establish the contents taken from the CM zip file as published after the upload is
complete, select the Publish Documents check box. This is the default setting.
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To establish the contents taken from the CM zip file as private after the upload is
complete, clear the Publish Documents check box.

4. Click Upload.

A confirmation dialog box opens. Click OK to complete the upload.

5. In the Upload a Zip File dialog box, click Close.

If an entry for the new CM zip file does not appear below the Import node, right-click it, and
then click Refresh.

Procedure: How to Import a Change Management Package

A user must be a Web Query administrator to Import a Change Management Package.

This step assumes that a Change Management Extract Package has been previously created
and has been copied to the target environment in this directory:

/qibm/userdata/qwebqry/base80/cm/import

1. The Change Management Export Package is selected from the Change Management
Import folder, and the option of Import is selected, as shown in the following image.
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2. A number of options are presented to the user, as shown in the following image.

Content Resources

Options in this group define the scope of content resources included in the Change
Management Import. Content resources include domains, portals, reports, charts, and
other features, located under the nodes of the Resources tree.

Add New Resource Only (do not replace). This option limits the import to content
resources in the Change Management package that do not already exist in the target
environment. The import process assigns the date and time of the import to the Created
On and Last Modified On fields of all new content resources created as a result of the
import. To view the Created On and Last Modified On fields, right-click an item and click
Properties.

Resources in the change management package that already exist in the target
environment arenot included in the import. As a result, the resources in the target
environment are not affected by the import, and the import does not update the value
assigned to the Last Modified On field.
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Add New and Update Existing Resources. This option permits the import to add new
resources to the target environment and update existing resources. The import process
assigns the date and time of the import to the Created On and Last Modified On fields of
all new content resources created as a result of the import. The import also assigns the
date and time of the import to the Last Modified on field of all existing items updated by
the import, but retains the original values in the Created On field.

Security Resources

Options in this group specify the actions to take if the change management package
includes the security resources Roles, Groups, or Users. A change management package
includes a security resource if it is selected explicitly, or if the Selecting With Rules check
box is selected for another type of resource.

Roles. Groups of user privileges. When included in a Change Management Import
package, they add to or update the list of roles maintained in the repository and visible in
the Security Center on the Roles tab.

Groups. Collections of users or subgroups that require similar capabilities or access to the
same resources. When included in a change management Import package, they add to or
update the list of existing groups maintained in the repository and visible in the Security
Center on the Users & Groups tab.

Users. Those individuals who have access to Web Query. When included in a change
management package, they add to or update the list of existing users maintained in the
repository and visible in the Security Center on the Users & Groups tab.

For each of the Security resource categories, there are two options governing the scope of
the import:

Add New. This option limits the import of security resources in the Change
Management package to those that do not already exist in the target environment.

Add/Replace. This option permits the import to add new security resources to the
target environment and update existing security resources.

Import Rules On Resources. This option specifies whether rules are imported from the
current change management package, and is only relevant if the package contains
exported rules.

As long as none of the security resource options are selected, the rules are imported
using the components of the rules that exist in the target environment.

For example, if you select Add New Resources Only (do not replace) and Import Rules On
Resources, the only rules that will be imported are the rules where all the components
(groups, roles, and, if necessary, users) exist in the target environment.
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If you select Add New Resources Only (do not replace) and Import Rules On Resources, and
then select Roles (Add New), the resources selected and the rules on those resources will
be imported. In this case, the roles will be added only if they do not exist in the target
environment and other components of the rules do exist in the target environment.
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